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Office/All Topo 9/7/00

Using All Topo Mapsto Bring in a Background Quad Map in
Pathfinder Officeor ArcView

Pathfinder Office, ArcView, and ArcExplorer can all display background image files,
such as Digital Raster Graphics (scanned images of USGS quad maps). These DRG files
are often available for free on the Internet; for example, the Idaho Department of Lands
and the Montana State Library both make collarless DRG’ s available for free. (Since
DRG’s are simply scanned images of USGS quad maps, they have the white border, or
‘collar,” with thetitle, scale, etc. on them. Some agencies have removed these collars
from their downloadable DRG'’ s so they can be tiled.) However, an individua quad map
is several megabytes in size, and often a person needs quad maps for quite alarge area. It
can be quite time-consuming and confusing to download individual files and try to keep
the names straight.

There are severa topo map programs commercially available, such as Delorme 3D Topo
Quad and iGage' s All Topo Map product. For asmall price, you can get the quad maps
for an entire state and view it seamlessly. However, Delorme’ s maps, for example, are
not exportable in a georeferenced format that is usable by Pathfinder Office or ArcView.
All Topo Maps, however, will let you easily find the area you want, then create a
seamless background file of the size you specify for use in Pathfinder Office or ArcView.
This tech note is designed to show you the steps in creating a background file for
anywhere in your state.

The All Topo Map product contains 3 main modules: the All Topo Map Viewer, Big
Topo Map Tool, and All Topo Map GPS Tool. The Map Viewer will alow you to search
for and work with individual quad maps. Y ou may search by place name or quad map
name, if you know it. The Big Topo Map Tool will be used to create a seamlesstiled
map containing multiple quad maps. The size of this Big Topo Map is user-specified.
The GPS Tool allows you to transfer waypoints and routes, as well as display your GPS
position on atopo map. We will not be using it for this exercise.

Select the Quad M ap of I nterest

1) First of al, open the All Topo Map Viewer by double-clicking on the All Topo
Maps icon on your desktop.

2) Next, from the Search menu, select Search by Place or Feature Name... You
could also search by Map Name if you knew the name of your quad map.

L“AII Topo Maps: Boise South; ID

File  Edit | Search Option:  Miew Help

Zoom: 100 ﬂ! Search by Place or Feature Mame. ..
dh Search by Location or Map Mame..  Alt+hd
# Search by Coordinate Location... A+l
23 Jump ta iMeasurement Spikel AlHE,
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3) If you know the complete name of the place you' re searching for, like Jerome, 1D,
or Rock Creek, typeit in on the Simple Search tab. If you only know part of the
name, click on Advanced Search and type in the partial string. When the place of
interest is highlighted on the list, press the Display Selected Place button. All
Topo Maps brings up the appropriate quad map. (Y ou may be prompted to enter
the correct CD with your map on it.)

t“ Search for a Place

Simple Search | Advanced Search I goto Search By Location 4 Map Mame | [ Addlos
1. Lok for a place named: IiBleEi 2. Dizplay Selected Place I‘—

Mame IType |County | Topokap |Elevatic-n ILat.n’L-:n |
Jenzon Spring; ID zpring Custer Big Blind Caryor 434811H113317
Jepzon Canwon [src); D wvalley Butte Methodist Creek. 435547M11321]
Jepzon Canyon; [D wvalley Butte Methodist Creek. 43852711323
Jericho Mine; 1D mine Cleanwater Little Green Mou 3700 464245M 11607
Jericho Maountain; 1D summit Clearwatel Little Green Mou 4325 454326M11607
Jerome; D Jerome  |Jerome

Jerome City Hall; 1D building Jerome | Jerome 424325M 114308
Jerome Country Club; 1D locale Jerome | Jerome 423808M11430;
Jerome County; 1D vl Jerome | Twin Fallz ME 4241004114161
Jerome County; 1D civil Jerome | Gooding SE 424730M114300
Jerome County Airport; 1D airport Jerome | Fallz City 4038 424333M11427

4) The quad map containing Jerome is displayed. | am already close to the edge of
this map, so | will want to use the Big Topo Map tool to create a seamlesstiled
map that’s centered on Jerome and is 5 miles square (this could be any number).
In order to do this, either make a note of the coordinates shown in the status bar,
or put your map cursor wherever you will want the center of your Big Topo map

to be and press Ctrl + X to copy the coordinate to the clipboard.
File Edit Search Options View Help

Zoom: 100% VI 250!
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M ake Big Topo M ap

*Note: To skip making a Big Topo map and simply export the single quad map currently
displayed, go to step 11. The single quad map will still have the collar.

5) Open the Big Topo Map program by double-clicking on the icon on your desktop.
The display shows the center coordinate of your output map as well as the height
and width. If you pressed Ctrl + X in the last step to copy coordinates to the
clipboard, smply press the button in the center of the screen. Otherwise, click on
the coordinate value and type in the coordinate from step 3.

=10 x|

=~ All Topo Maps: BigTopo

Fie Help

ﬂlr\l 427 45682, W 1147 34155

E UTH Zane = 11

N 427 43448 W/ 114" 31.337

4.334 Miles

|N 427 41212 W 1147 28,485 EI

'_S_et_tirjgs_l 'Anmatatiansl Output File | Build BingpaEI Activity L':'gl

—_E_!igT'u:upc: Dutput Infarmatian
BigT opo autput to C:APROGRAM
FILESMALLTOPOARIQT opatBigT opa. T3

Map size 2,329 pixels wide by 2,287 pixels high, if printed at 1:24,000
scale [2.64 inch/mile, 160 DF). the image size will be 14.5 inches wide by
14.3 inches high. :

Thiz image will take about 5 326 423 bytes of systern memary [FéaM and
wirtual space] to build.

L-'I'_aj!ke BigTopo Ereviem Eurentinage

| V.
6) Next, type the height and width of your desired output map in the appropriate text

boxes. These can bein any unit of measure. Simply type the unit of measure or
its abbreviation after the number.
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7) Now click on the Annotations tab. Unless you want your resulting map to be re-
collared with a Map Scale Bar, uncheck the Include a Map Scale button, and then
uncheck the Recollar (add borders to) Big Topo option.

| Output File | Build BigT

— p [ Recollar [add borders to) BigT opo

—Callared Annatation Optian
rSouth Eazt Carner Title

| e e DT G e Big Tepn
\ [T Eeerlanlatdiam Eid o Big Topa

[T IHelideia e S eale

8) Next click on the Output File tab. Click on the Browse button to specify a
different path and file name.

Settingsl Annotations  Dutput File | Euild EigTu:upu:uI Activity Lu:ugl
% Dutput BigTopo to ANl Topo Maps
&l Topo kMaps Map MName
|E:'xPHEIGH£‘«M FILESSALLTOPORigTopohBigT apa.lT

File Comprezsion [dogz not change image quality]
" Masimum [slow] 0 High T Low [fast]

{~ Ew=port BigTopo az generic graphic picture

Type in the file name and press Save.

Export BigTopo To All Topo Maps EE
Saveine [ 3 BioTopo H il
Objsct name: |ieromalIT3 dave I
Save as fype: IITS-AII Topo Maps j Cancel |

2

9) Next click on the Build Big Topo tab and press the Make Big Topo button.
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Settingsl .ﬁ.nnutatiunsl Output File ~ Build BigTopo | Activity Log

—BigTopo Output [nformatior
BigTopo output to C:5Program FileshAIT opobBigT opohjerame. | T3

tap zize 2,109 pixelz wide by 2112 pisels high, if printed at 1:24,000
zoale [2.64 inchdmile, 160 DF], the image size will be 13.2 inches wide by
13.2 inchesz high.

Thiz image will take about 4,454,208 bytes af system memaon [Fak and
wirtual zpace] to build.

Make BigTopo EreweniEurentimane

The Activity Log will inform you of the progress.

Settingsl .ﬁ.nnntatiunsl Oikput Filei Build BigTopa  Activity Log |

BigT opo intialized in 0 seconds. |
Allocated 4,454 208 bytes for output image. .. Decompressing

Loading source map Goading SE; 1D fram C:4P DoAMARDATANIA2TT14F41T 2

Gooding SE; 1D loaded in 1 zecond ko

[9/22] Colors matched in 0 zeconds YWPROGRARM FILESYWALLTORPOACACHESD 42114F4. b

Copied 466,712 pixelz from Gooding SE; 1D in |

Loading source map Shoghone 5% (D from C:*
Shozhone SW; 1D loaded in 0 geconds

[2#24] Colors matched in 0 geconds

Copied 167,724 pivelz from Shoshane 54w/ 10 i | R

-

1] | il

When finished, the status line will tell the resulting image and its size.

|Dutput image C:A\Program Filesh AT opohBigT opohjerome.| T3 occupies 732,784 bytes.

Open Big Topo Map in All Topo Map Viewer and Export to Pathfinder Office or
ArcView

10) Now close the Big Topo Tool. Switch to the All Topo Map Viewer. From the
File menu, select Open Big Topo Map.... Select the file created in step 9 and

press Open.

File Edit Search Options Miew Help Lookin: | 3l BiTcpa B EI ’ﬁ] _r_ﬂ Eﬂl
(= Open Map Set.. I
?_!)i Open BigT opo Map Chrl+B
S Expart Map ta GIS/CAD ..
% Setup Printer, Map Scale... Ctrl+R
Print Yiewed kMap Ctrl+F

Eririt Entire Map e R =l

E uit Alr+F4 Flewal ypms AN T o0 ap Pl [ = | Caredd
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11) To export the map to a georeferenced image that Pathfinder Office or ArcView
can use, from the File menu, select Export Map to GIS/CAD....

' || Topo Maps: jerome

| File Edit Search Options Yiew Help
(= Open tap Set...

?g Open BigT opo Map Clrl+B
@J Export Map to GISACAD...

% Setup Printer, Map Scale... Ctrl+R
Frint Viewed Map Chrl+F

12) The Map Export Wizard appears. Export the Entire map to an Image File. Name
the output TIF file whatever you would like. Make sure to check the box to Write
a.tfw worldfile. (World files contain the georeferencing information necessary
for Pathfinder Office or ArcView to load the image correctly.) You may aso
choose to include Coordinate Annotations and Compress or Resampl e the output
image. Compression could make the TIF file unreadable by Pathfinder Office.

All output images will be in UTM, NAD1927, since thisis the coordinate system
of the original quad maps.

Map Export Wizard
1. Export .
; : . Esepinit W aay i oo 13" 7] =]
£ just the Yiewed map + | the Entire map - ET S el v ol EE
2 To
| the Windows Clipboard [as a Bitmap)
% an Image File:
!E:"-.F'HEIGH.-’-'-.M FILES"ALLTOPONUSERjerome TIF _]
v #afrite description of map image to: C:APROGRAM FILESSALLTE
v 'wirite a thw worldfile to: C:APROGRAM FILESYALLTOPO4YUSEF N

[T Compress output file if possible

Saveasiyos: | TIF + TPef+ BRP

—3. Image Optiaon
[ Include Source Map Mame

S
= Cancel
S

Source Image Width I3293 Height I4441 pixelz

Output Image Width ISEEE Height |4441 ' pixels
Exported image will ooccupy 14,624 269 butes in memon.

o Export x Cancel
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Ihclude Coordinate Annotations
[ eday LT i s The Export Wizard does not appear
I e e in the old version, which appears as
[T Include Coordinate Mames above. Download the new All
[ Include I:::u-:uru:l!nate Dezchnptions TOpO viewer for free from
[T Include Coordinate Motes )

! Fiseaieté DUt e http://www.alltopo.com/alpha/.
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L oading the Background Filein Pathfinder Office

13) Open Pathfinder Office. From the Options menu, select Coordinate System.

File Edit “iew Data Qtilities|gptiuns Window Help

ElEl i%il F&gﬁl l@r Urits...

Coordinate System...

@||m St Of Display..
|

14) Set the display Coordinate System to UTM with the appropriate zone for your
area. Datum is NAD 1927 (Conus), and the coordinate units are meters. Press
OK when finished.

Coordinate System

- Select By
' Coordinate System and Zore Cancel |
51 Site

Help |

System: I Uriverzal Tranzverze Mercator

£one {11 North

i
H

Datum: ISR

— Altitude Meazured Fram
" Height Above Ellipsoid [HAE)

¥ Mean Sea Level (MSL)
— Geoid Model

% Defined Geoid (EGMIE (Glabal)
£ Other
Geoid: [EGM35 (Global) =

LCoordinate Lnits: IMeters ;i
Altitude Units: |MHE,S =]

15) From the File menu, select Background....
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[*%] Pathfinder Office

File Edit ‘“iew Data Ll
Open... Chl+0
SavE {Eir| =
BavEsE, I
[ElEge

R

FProjects. .

Background...

Waypoints L
Elerkdes ferel il

16) Now click the Add button and select your TIF image created in step 12.

Load Background Files

File Mames 0k

Cancel

Elermaye

Help

Coardinate syster of zelected file(z]:
Sike:

System:;

Zaone;

Dratun:

[Eharge:.

| B[

17) Pathfinder Office will warn you to specify the coordinate system of the
background file. In the case of image files, the coordinate system of the
background file must match the display coordinate system, which is why we
performed steps 13 and 14. Press OK to dismiss the message.

Pathfinder Dffice

-
I\lf) Please remember to et the corect coordinate syztem of each new background file. If the coordinate syztem iz incomect it will display incomectiy in the kap window.

18) Pathfinder Office will now show your file in the Background File list with a
checkbox next to it. Verify that the Coordinate System of the selected file at the
bottom of the dialog box is correct. Press OK to draw the map.
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Load Background Files

File Mames Ok,
FC WPFDAT AN erome. tif

Cloze
Add

Bemowve

Help

Coordinate spztern of zelected file(s);
Site: nia

——» Sustem: Urniverzal Tranzverse Mercator
Zone: 11 Horth
Datur: MAD 1927 [Conusz)

Change...

[ FEFE

Now you can open and print regular data files on top of your background image.
If at any time you would like to turn off background map display, simply go back to
File, Background... and uncheck the check box next to the filename to turn it off.
Pressthe Add... button to add other background maps.

OR

Adding TIF Imageasa Themein ArcView

13) Start ArcView. From the File menu, select Extensions....

Edit View TIheme Grapk
LCloge
Cloze All

Set Warking Directory. .
Save Project Chil+5
Save Project bz

14) Turn on the TIFF 6.0 Image Support extension and press OK. Thiswill allow
you to add the quad map as athemein ArcView
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i Extensions

Available Extenzions:

| Projection Utility 'wfizard _:J | (0] 4 I
| Repart Writer

) ) Cancel |
_ | Snap line- or polygonT heme to PointTE
| Spatial Analyst
ﬂ TIFF 6.0 Image Support Reset |
| VPR Viewer [ Make Default
_ | #Toolz Extenzion -

15) Open an existing View or create a New View.

= Open
A
@

Py

16) Press the Add Theme button.
VoTE

17) In the Add Theme dialog box, change the Data Source Type in the lower left-
hand corner from Feature Data Source to Image Data Source.

& Add Theme

Directory: | o ok |
prse Cancel
£ altopo 4|
£ azpen
£ &t
£ backup
[ cavedog % Directories
= 0 del " Libraries
= M downloads Li
[rata Source Tupes: Dirives:
Feature [ ata 5ource = = |

= Feature Data Source =
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19) Browse to the directory containing your TIF image created earlier by double-
clicking on the folders in the right-hand column. Select your TIF image in the
left-hand column and press OK.

& Add Theme

Mirectany: | r-hpfdata Ok |
el A A = 2 Earieal |
B tobacco.hf
£ default
23 gilluly
£ goodman
£ roads & Direcharies
— £ support . Libraries
ol "1 hutarial Li
Dala Suuce Tepes, Dives.
| Imane Data Source =l |c =]

20) ArcView will add the image as atheme. Click the raised check-box in the table
of contentsto turn the display of this theme on.

22 Viewl

ﬂ Jderom e tif

21) Y ou can now add other themes to the view in the same manner. If they arein the
same coordinate system (UTM, NAD1927, Zone 11 in this case), they will
display over the top of your image. Y ou will not have to set a projection for the
view. If the other vector themes you will be adding are unprojected
(latitude/longitude), then you will have to set the Projection of the View to match
your image. To do this, select View, then Properties....

NN Theme [Graphice:  Winc

22) In the View Properties Dialog Box, click the Projection... button.
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";" View Properties

Mame: | View SRR
Creation Date; |'wednesday. Julp 19, 2000 10:48:01 &M _ﬂi
Creatar: |

tap Units: | yrknown i

Bistanee Wt [ unknawn I~

Backaround Calar; [ﬁ] Select Color... |

Comments;

23) In the Projection Properties Dialog Box, select UTM — 1927 as the Category and
Zone 11 asthe Type. Pressthe OK button. Now your unprojected (lat/long)
vector data (shapefiles, etc.) will be projected to the same coordinate system as
your image and they will overlay correctly.

"._J Projection Properties

¢ Standard " Custam

Category: 3N

Tepe: | Zone 11 =l

Projection: Transverse Mercator
Sphemid: Clarke 1866

Central Meridian: -117
Reference Latitude: O

Scale Factor: 0.9336

Falze Easting: 500000

Falze Marthing: 0
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Although the process of getting a seamless tiled output map does take several
steps to perform, the good news is that you can now get all the topo maps for an
entire state for around $120 - 150, and they will work with Pathfinder Office and
ArcView. This process may only have to be performed once to create alarge
background file for your entire area of concern.

**All Topo Maps are available for the following states:

Arizona, Colorado, Idaho, Utah, Nevada, and New M exico: $118.50
Montana: 128.50
Wyoming: 132.50
Texas. 148.50

Please call Electronic Data Solutions at (208) 324-8006 to order, or see our Web
store at http://www.geoposition.com.
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